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Simple drawing setup. 
 
In the following section, we will be focusing on creating a simple drawing layout. 
 
For this we will create a simple Title Block template and use the Layout Editor to position the 
template in the required location. This layout will then be used to generate a drawing where 
we will use the previously created filters and naming conventions to create a style for our 
drawings which can reflect our drawing office standards. 
 
As you will appreciate, there is a vast amount of information and functionality contained in 
the drawing system and this is only a small part of that. The processes involved, however, 
create a foundation to add more automation and control to your drawing presentation.  
For example, You will be able to explore other settings and add them to the saved setting 
made here for properties such as Text style, Part Marks, Rebar marks, Reference models 
etc.  
 
But for now, we will concentrate on this initial foundation setting. 
 
This will be broken down into 3 main sections as it is the largest of the 4 tutorials. 
 
Template. The Template Editor will be used to create a basic Title Block from an existing 
dwg. This is the simplest method of creating a template. There is an example provided for 
use but you can follow with your own. Once created we will also map some attributes from 
Tekla Structures to the Title Block to show how the system populates data from the 
database. 
 
Layout Editor. Once the template is created a blank GA with no layout will be created and 
the Layout Editor will be used to add the Title block to the desired location, set the page 
sizes available and then create the layout to be used in such GA’s  
 
Drawing Object Level settings. In the model we will add several objects to the grid. Beams 
columns of differing material. A GA will be created using the new layout. Once created the 
required Object - Part drawing properties will be created or existing ones used to create line 
type, hidden line type and hatching settings required for each object type. These will then be 
mapped to the objects in the drawing using the Detailed object level settings and the filters 
created in the earlier lesson to pick them out.  
 
 
 
 
 
 
 
 
 
 



 

Part One - Templates. 
 
Templates are used within Tekla Structures to pull information stored within the database 
into usable reports and graphical template layouts such as drawings and Bar Bending 
schedules. 
 
They can be built to use rules and formulas which can collect, collate, sort and quantify 
anything you have modelled, any data you have added to the project or drawings, external 
models and many many more. 
 
In order to create a template, Tekla Structures comes with a program called the Template 
Editor. We will not go into the finer point of this tool here as we will focus on the required 
information for building a simple Title Block. 
 
Suffice it to say, there is a wealth of information regarding the Template Editor in TUA and 
here are a few useful links for your further exploration. 
https://teklastructures.support.tekla.com/video-tutorials/en/introduction_to_template_editor 
https://teklastructures.support.tekla.com/2020/en/rep_templates 
https://teklastructures.support.tekla.com/2020/en/rep_template_editor_user_guide 
 

  

https://teklastructures.support.tekla.com/video-tutorials/en/introduction_to_template_editor
https://teklastructures.support.tekla.com/2020/en/rep_templates
https://teklastructures.support.tekla.com/2020/en/rep_template_editor_user_guide


 

Creating a template from a drawing. 
 
This is the simplest method for creating a template and will be the one we follow. 
There is a useful link here which shows the basic process. 
 
For creating a title block this is the preferred method due to the high likelihood of our users 
having a previously created dwg template from 2D Cad in a dwg format.  
 
The Template Editor is able to import this and convert the line work to Tekla Structures 
format and convert any texts. This removes the requirement of drawing the title block again 
in the Template Editor. 
 
 
 
 

 
Or if you want to dive straight in then you are able to use one of your own. 
 
Note: DWGs should have their border in the model space. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Tutorial. 

Step 1. 
Open Tekla Structures. 
 

 
 
Create a new model - Call it “Template lesson”. 
 

 
 
 



 

In the File menu select  - Editors - Template Editor. 
( Opening from here will open your current version of Tekla Structures Template Editor. ) 
 

 

 
 
 
 
 
 



 

Step 2. 
In the Template Editor software create a new Graphical Template. 
 
Select - File - New. 
 

 
 
Select - Graphical Template. 
 

 
 
You will see a content area appear in the main window of the Template Editor. 
 



 

 
 

Step 3. 
Remove the margins from the template. 
The margins are a padding around the template itself which position the content within the 
defined boundary. We do not want these in the templates so will have to remove them 

 
 
To do this, double click the background to open the Template Page Properties. 
 
Change the Margins values from 10 to 0 as shown below and click the OK button. 
 

 



 

Step 4. 
We will now add a content Row to the template. 
Rows come in many forms and allow the system to pull data from many different object 
groups. 
 
We will create a DRAWING row. This, as the name suggests will pull relevant data from the 
Drawing. 
 
Select - Insert - Component - Row 
 

 
 
A new dialog will open. 
Select DRAWING from the dropdown list and click the OK button. 
 



 

 

 
Notice the DRAWING row has been added to the main window but also into the Sorting and 
drawing order side pane.  
 
Note:You can learn more about the different content type rows, hierarchy and sorting in the 
links at the beginning of this guide. 
 

Step 5. 
We now need to add the DWG file inside the DRAWING row. 
 
Select - Insert - File 
 



 

 
 
In the Open dialog, browse to your DWG file.  
(You can download the one used in this tutorial here - hyperlink here) 
 
Select the file. 
Click OK. 
 

 
 



 

Select a point in the DRAWING row. 
 

 
 
 
 
In the next dialog, select the scale 1:1 option and OK. 
 

 
 
The DWG will be converted to line work and added into the DRAWING row. 
 
It will look something like this  
 



 

 
 
 

Step 6. 
Remove unwanted linework if needed. We are only interested in the Title Block for this 
tutorial. 

 



 

 
We break down drawing sheets in Tekla Structures into smaller blocks. To do this from an 
existing dwg we typically remove all other linework and text, leaving the required block. 
This could, of course, be done prior to inserting into the Template Editor. 
 
Select the inserted file in the DRAWING row. 
 
Rightclick - Select - Ungroup. 
 

 
 
This will break the inserted block down to lines. You can see this has been done in the side 
pane. Which will have changed from this: 
 

 



 

To this: 
 

 
 
 
Select all lines and texts which you do NOT require and delete them. 
You can do this by selecting individual objects or windowing many in the view and pressing 
the delete key. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

In this instance, this will leave us with the title block linework and texts only like below: 
 

 
 

Step 7. 
Resize the Row.  
At the moment the Row itself is still the size of the original DWG which we imported. We 
want this to fit the Title Block we now have remaining inside it. 
 
Select the Row.  
Right click and select crop 
 

 



 

Choose Template left side and then repeat for all the remaining options. 
Unfortunately this is not a continuous command and you will have to perform it each time for 
each side and the height. 
 
Once done the template should look like this: 

 
 
We are left with the finished linework and are ready to add template attributes. 
 

Step 8. 
Valuefields. 
 
Value Fields are containers for information used by Tekla Structures. We can call the 
contents of these containers by adding the desired attribute property to the valuefield. 
 
For Example, If we want to display the information we have added to the Project Number 
field in the Models Project properties area we will use the PROJECT.NUMBER attribute in 
the required valuefield.  
 
We will add a few to the template here but using the same process you will be able to add all 
that you require. 
 
We will add Project and Drawing attributes. 

● Project Number 
● Project Name 
● Drawing Name 

 
The process is the same for all of these and you can continue to other properties as you 
need to. 
 
 
 
 
 



 

Select the Insert menu and value field. 
 

 
 
Place the value field in the free space adjacent to the CONTRACT NO: text. 
 

 
 
 
 
 
 
 



 

The value field Select Attribute dialog box will open where you can select an attribute with 
default properties. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

We are adding a Project level property here so will need to scroll down to the PROJECT 
folder, expand it and choose the relevant attribute. In this case the NUMBER attribute. 
 

 
 
Select this and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

This relates to the Project number from the Project Properties in Tekla Structures found in its 
File Menu. 
 

 
 
We want to change the properties of this value field to suit out drawing office standards for 
example. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Double click the newly added Value field. The Value Field Properties dialog will open. 
 

 
 
In this dialog you can control properties of the value field output, such as: 

● Attribute used 
● Formulas (if required) 
● Data Type - Text, Number, Number 
● Meaning - Length, Weight, Volume, Date/Time etc with decimals 
● Order - Ascending, Descending, None  
● Layout - Font, size colour etc, Justify, Length etc 

 
 
 
 
 
 
 
 
 
 
 



 

We will change the text properties. 
At the bottom of the dialog next to the font and text height, click the … button 
 

 
 
Amend the text properties to suit your standards.  
For example, Ariel Narrow and height 2.5 
 

 
 
OK this sub-dialog and then Apply and OK the main dialog.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Step 9. 
 
Repeat the above process for Project Name and Drawing Title.  
 
Note: the Drawing Name attribute equates to TITLE in the attributes list. 
 
Tip: If able you should copy an existing Value field and paste it and then amend the attribute 
to the desired one. This way font etc is preserved. 
 
Select the Project Number valuefield.  
Right click and select Copy 
 

 
 
Paste the copied field next to the PROJECT text in the template. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
Double click the value field  
Click the Attribute button and select PROJECT → NAME. 
You can also change the font size if required. 
 

 
  
Click Apply and OK 
Repeat the process for the DRAWING → TITLE attribute. 
 
You can continue with this process in order to fill out all of your requirements. The process, 
however, is the same so for the purpose of the tutorial, we will finish the editing process 
here. 
 
 
 
 
 
 
 
 
 
 



 

 

Step 10. 
 
Save the file to the firm folder created earlier. 
 
Open File - Save or click the Save icon 
 

 
 
Browse to the location of your Firm folder. 
 
Call the file A1_TitleBlock_GA (or relevant name) then click OK. 
 

 



 

 
We will be able to test the file working after completing the next tutorial. 

Part Two - Drawing Layout Editor. 
 
The Drawing Layout Editor is a tool within Tekla Structures which we use to create drawing 
borders, bar bending schedules, automated tables etc. 
 
In this section we will use the Drawing Layout Editor to create our drawing sheet with the 
Title Block created in the previous section.  
 
This will be a simple introduction to the process of creating a layout, creating a drawing 
paper size to be used and then adding tables (our template) to this drawing layout. 
 
There is also an excellent guide to the Layout Editor in Tekla User Assistance which goes 
through many more functionalities of this tool. This is advised reading for those looking to 
administer the Tekla Structures software.  
 
https://teklastructures.support.tekla.com/2021/en/dra_edit_drawing_layouts 
 

Tutorial. 
 

Step 1. 
Open Tekla Structures ensuring that you are using the role created to use your firm folder. 
This will start up Tekla Structures with the files we have previously created in this guide. 
 

 

https://teklastructures.support.tekla.com/2021/en/dra_edit_drawing_layouts


 

Step 2. 
Create a new model and call this model - Drawing Layout. 
 

 
 

Step 3. 
Open the Drawing Layout Editor. 
 
Open the File Menu → Select Editors → Drawing Layout Editor. 
 

 



 

This will open the editor window. It will automatically open with a predefined layout from your 
installation.  

 
 

Step 4. 
Create a new layout.  
 
Click the Create Layout button on the tools ribbon. 
 

 
 
 
 
 
 
 
 
 
 
 



 

In the Create drawing layout dialog box give the layout a name and select a drawing size. 
 
Name - GA Layout 
Drawing size - A1 
Click Create 
 

 
 
Note that the drawing layout can contain several page sizes and each size can contain 
differing templates if required.  
 
The A1 “canvas” will be displayed. 
 

 
 
 
 
 
 
 



 

Step 5. 
Set the Drawing Layout type. 
We are going to make this layout for General Arrangement drawings but you are able to set 
these for all drawing types here. 
 

 
 

Step 6. 
Add an additional page size. 
We will add an A3 page size to the Layout also. 
 
In the Drawing size area click the pen icon. 
 

 
 
 
 



 

The Drawing size settings dialog will open and display the current drawing size - A1. 
Click the + Icon to add a new line and select A3 from the drop down list. 
 

 
 
Once selected the correct size for the page will be displayed. 
 

 
 
Note: You are also able to create custom sizes by adding a new size and typing a name. 
You can then set the page size by double clicking the WIDTH and HEIGHT fields and adding 
new sizes. 



 

Click OK to add the new size to the Layout. 
 
It will now appear in the Drawing size area of the editor window. 
 

 
 

Step 7. 
Adding a table to the layout. 
 
We will now add the template we created earlier to the sheet. As long as the template is in 
the firm folder it will be available to select in the Add tables list. 
 
Select Add tables from the ribbon. 
Find the required template and select. 
A1_TitleBlock_GA 
 

 



 

During this operation the Available tables dialog will remain open until you have finished 
adding templates to the layout. 
 
Once the template is selected a crosshair will appear in the window for you to pick an 
insertion point. 
 
We will pick the bottom right hand corner of the layout. 
 

 
 
The template will appear and be pinned to this corner. 
 

 



 

Notice how the value fields will populate with the associated data from the Tekla Structures 
database if there is a value in them. 
 
If you are going to continue to add other tables you can repeat the above process and place 
them where required. 
 
Once done click the close button on the Available tables dialog. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Step 8. 
Save the drawing layout and drawing sizes and close the Layout editor. 
 
Even though we have added the template to the A1 drawing size only, at the point of saving 
we are able to update any of the other drawing sizes with the changes we have made.  
This makes creating multiple sheets much easier. 
 
Click the Save as icon on the ribbon. 
Ensure the A1 and A3 drawing sizes are checked in the UPDATE column. 
Click Save 
 

 
 
Click the Close Layout editor icon on the ribbon. 
 

 



 

Step 9. 
Create a GA drawing setting which uses the newly created layout. 
 
Click Drawings and Reports Menu on the ribbon. 
Select Drawing Properties and choose GA drawing 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

The GA drawing properties dialog will open. 
 
Click the Layout button. 
 

 
 
 
 
 
 
 
 



 

In the General - Layout Properties dialog, select the GA Layout we created earlier. 
 

 
 
Once selected the Drawing sizes associated with that Layout will be available in the Drawing 
size area of the dialog box. 
 
Select the A1 size and click OK. 
 

 
 
For now this is the only change we will make here. In the next section we will add Object 
level settings to control the presentation of the model objects in the drawing. 
 
 
 
 
 
 
 
 



 

In the Save as field name the setting A1_GA_Setting and click the Save as button. 
 

 
 
The saved setting will now be available in the Load dropdown. 
 

 
 

Step 10. 
Test the new layout using the drawing setting. 
We will create a blank GA for this test. 
 
In the Drawings and Reports menu select the Create drawings dropdown menu and choose 
GA drawing. 
 

  
In the Create General Arrangement Drawing dialog. 



 

Select a view 
Select Empty drawing from the dropdown 
Click the Drawing properties button. 
 

 
 
The General arrangement drawing properties dialog will open. 
 
Select the A1_GA_Setting from the Load dropdown. 
Click Load 
Click Apply - OK 
 

 



 

This will set the properties ready for creating the drawing and close down the dialog. 
 
Back in the Create General Arrangement Drawing dialog 
Check Open drawing tick box 
Click Create. 
 

 
 
The GA drawing will now be created and will open once completed. 
 

 
 
 
Our new template at the bottom as constructed in the Drawing Layout Editor. 



 

 

 
 

Step 11. 
Move the created settings file to the firm folder for use in all other models. 
 
The files we have created will be in the Model folders attributes folder. 
 
\Drawing Layout\attributes.. 
 
The files created are the layout file (.lay) and the GA drawing setting file (.gd, .gd.filter and 
.gd.more) 
 

 
 
Select these files and copy to your FIRM folder. 
 
Place them in the Drawing_Settings folder. 
 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Part Three - Drawing Object Level Settings. 
 
In this final section we will see how we are able to bring everything we have learnt and 
created over the previous 3 lessons together onto our drawing sheet. 
 
Our Firm Folder holds all of the files, our Naming and Numbering conventions providing 
definitions to our modelled objects, our filters to find and select them, our drawing templates 
and layout to show them and now our object level settings to provide the presentation of 
those objects in the drawn space. 
 
Each section leading and providing information for the next.  
 
We will begin by creating a simple model which will contain a few objects which we want to 
control the presentation of in the drawing itself. 
 
These will be a combination of steel and concrete members and will include the Ledge Beam 
we created in lesson 2. 
 
Once you have created these settings you will add them to the Naming and Numbering 
conventions spreadsheet.  
 
 

Object 
Type 

Name Part 
Prefix 

Part Start 
Number 

Assembly
/Cast Unit 

Prefix 

Assembly
/Cast Unit 

Start 
Number 

Filter  Drawing 
Object 
Setting 

Steel 
Beam 

Beam M 1 B 1 SS Beam (used in 
later 

tutorial) 

Steel 
Column 

Column M 1 C 1 SS 
Column 

 

Steel 
Rafter 

Rafter M 1 R 1 SS Rafter  

Steel 
Purlin 

Purlin M 1 PN 1 SS Purlin  

Concrete 
Beam 

Beam - - CB 1 SIC Beam  

Concrete 
Column 

Column - - CC 1 SIC 
Column 

 

Concrete 
Pile 

Pile - - CP 1 SIC Pile  

Concrete 
Ledge 
Beam* 

Ledge 
Beam  

- - LB 1 SIC 
Ledge 
Beam 

 



 

After the completion of this basic tutorial you will be able to continue on your own to add all 
of the required Drawing Object level settings for your drawing office standards. 
 
There is some excellent information on this in Tekla User Assistance and it is recommended 
reading to understand the inner workings of the drawing system and the Object Level 
settings. 
https://teklastructures.support.tekla.com/2021/en/dra_three_levels_of_modifying_drawings 
https://teklastructures.support.tekla.com/2021/en/dra_detailed_object_level_settings?da=GU
ID-1376E07C-F8F8-413F-A48D-A30DBDED48D5 
 

Tutorial. 

Step 1. 
 
Open Tekla Structures ensuring that the firm folder is selected. 
 

 
 
Create a New model called Drawing Object Level Settings. 
 

 

https://teklastructures.support.tekla.com/2021/en/dra_three_levels_of_modifying_drawings
https://teklastructures.support.tekla.com/2021/en/dra_detailed_object_level_settings?da=GUID-1376E07C-F8F8-413F-A48D-A30DBDED48D5
https://teklastructures.support.tekla.com/2021/en/dra_detailed_object_level_settings?da=GUID-1376E07C-F8F8-413F-A48D-A30DBDED48D5


 

Step 2. 
Once open we are going to model some objects into the 3d view. These just have to be 
some example members. 
 
We will model in some Pad Footings, Steel Columns and Beams, some Bracing, and then 
some Concrete Columns and Beams, Hollowcore and Slabs- Ensure that you model in the 
Ledge Beam from the earlier lesson. 
 
Something like this will suffice. 
 

 
 
The model does not have to be precise, just indicative of the model objects you will create in 
your projects. You could also use one of your own, previously created models. 
 
 
 
 
 
 
 
 
 
 



 

Step 3. 
Create some elevation views. 
These will help us test the settings we create later on. These should be created in locations 
which show a good cross-section of your modelled objects. 
 
In the above model these will be created along grids B and C as these will show both steel 
and concrete elevations. 
 
In the VIew menu select New view → Using two points. 
 

 
 
Select two points along the grid line you have chosen to use. 
 

 



 

The green arrows indicate the created views direction. 
 
In the newly created view double click the background to open the View properties. 
Set them as below. 
 

 
 
The view should look similar to this. 
 

 
 
Repeat this process for any other relevant sections you wish to use later. 



 

For example: 

 
 
 

Step 4. 
Create GA using previously saved A1_GA_Setting from the previous lesson. 
 
We will use the 3d view to create the first drawing. 
Set up the view up orientation as below. 
 

 
 



 

Go to the Drawings and Reports ribbon. 
Select the Create Drawings dropdown. 
Choose Create GA drawing. 
 

 
 
In the Create General Arrangement Drawing dialog. 
Select the 3d view in the list. 
Click the Drawing properties button. 
 

 
 
 
 
 
 



 

In the General arrangement drawing properties. 
Select the Load dropdown menu 
Choose your saved setting from the last lesson - A1_GA_Setting. 
Click Load. 
Choose Apply to use these settings. 
Click OK 
 

 
 
 
 
 



 

In the Create General Arrangement Drawing dialog. 
Set Options to either 

● All selected views to one drawing 
● One drawing per view 

Check the Open drawing box 
Click Create. 
 
The drawing will open and should look something like this. 
 

 
Note how all of the objects are drawn in the same style and colour. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Creating the Part representations. 
 
Using the General arrangement drawing properties you are able to create and save required 
Part representation settings and save them for use in the detailed object level settings area. 
 
You can for example make a setting for each object you want individually, which would 
create many files but be very detailed. Or you can create more general settings based upon 
the line type you require and then map that to the required part. 
 
We will be doing the latter and be creating two settings each for Steel and Concrete in 
different colours. 

● Hidden Line 
○ Inc own hidden lines 

● Non-hidden line 
 
It is worth pointing out here that the colour you assign to the Part representation is important 
as these are mapped to your line thicknesses when printing the drawings. 
 
There are some good explanations of how this works in TUA but we will not be going into 
this here. 
https://teklastructures.support.tekla.com/2020/en/dra_show_printer_lidewidth_in_drawings 
https://teklastructures.support.tekla.com/2020/en/dra_colors_in_drawings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://teklastructures.support.tekla.com/2020/en/dra_show_printer_lidewidth_in_drawings
https://teklastructures.support.tekla.com/2020/en/dra_colors_in_drawings


 

To see how these are built up double click the GA drawing background to open the 
properties. 
 

 
 
 
 
 
 
 
 



 

Click the Edit settings button to open the Object level settings for the general arrangement 
drawing properties. 
 

 
 
This dialog allows us to combine drawing filters with drawing object types and then by the 
saved property settings. 
 

● The first column, drawing filter, will identify the required object in the drawing  
● The second column, Drawing object type, will turn on the drawing object type for the 

filtered object/s only 
● The third column, Settings used, will then apply the saved settings chosen and effect 

the object in the drawing accordingly 
 
Note: We have already created filters which we can use in previous lessons.  
You can also create new ones using the drawing filter dialog if required. 
 
 
 
 
 
 



 

Before Object Level settings: 

 
After Object Level settings: 
 

 
 
 
 
 
 
 
 
 



 

Step 5. 
Creating the required drawing object properties. 
 
We first need to create the required setting for the object to use in the drawing. We can do 
this in the General arrangement drawing properties dialog box in the Objects section 
 

 
 
 
 



 

Select the Part button to open the Part properties dialog. 
There are three tabs which allow us to set the: 
 

● Content - What will be shown of the object. 
○ Representation 
○ Hidden lines/Own hidden lines 
○ Center and Reference lines 
○ Additional marks 

 

 
 

● Appearance - The Colour and Line Type 
○ Visible lines 
○ Hidden lines, Center lines 
○ Reference lines 

 

 
 
 



 

● Fill - The objects hatching settings 
○ Part faces 
○ Sections 

 

 
 
As mentioned at the beginning of this section, we will be making two settings for steel and 
concrete objects. They will be different colours and one will show hidden lines and one will 
not.  
 
Starting with the Steel object setting. We will set the tabs as follows. 
 
Content: 

● Hidden and Own hidden lines on/off boxes ticked 
● All other settings remain the same 

 

 
 
 



 

Appearance: 
● Visible lines  

○ Colour - Blue 
○ Type - Solid line 

● Hidden lines, Center line 
○ Colour - Blue 
○ Type - Dashed 

 

 
 
Fill: 

● Part faces - No change  
● Sections 

○ Type - ANSI31 
○ Colour - Blue 
○ Background - None 
○ Scale - Custom - X 1.25 (keep ratio of x and y to get y) 

 

 
 



 

Save the property as - Blue Steel Hidden. 
This naming convention denotes the colour, the material and the representation.  
 
We will repeat this process for the steel object using Green and unticking the Hidden line 
properties. 
 
The Naming convention will then be - Green Steel for example. 
 
For the concrete object properties we will create only a Black variant of each Hidden and 
Non-hidden but change the Fill properties. 
 

● Fill 
○ Part faces 

■ Hidden setting 
● Type - Hardware_SOLID 
● Colour - Medium Grey 

■ Non-Hidden setting 
● Type - Hardware_SOLID 
● Colour - Medium Grey 

○ Sections 
■ Type - AR-CONC 
■ Colour - Medium Grey 
■ Background - None 
■ Scale - Custom - X 1 

 

 
 
Save the Hidden setting - Black Concrete Hidden 
Save the Non-hidden setting - Black Concrete 
 
 
 
 



 

You can continue to make any other part representations you require. 
 
For example: 
 

 
 
 

Step 6. 
Set up the Detailed object level setting. 
 
In the General arrangement drawing properties click the Edit settings button. 
 
In the Object level settings dialog we will start to build the settings from the filters made 
earlier and the part settings we have just created. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Step 7. 
Click Add row. 
 

 
 

Step 8. 
Set up the three columns using the Naming conventions sheet from Lesson 3. 
 
Create as below. 
 

 
 
Click modify once completed. 



 

You should see this result. 
 

 
 

Step 9. 
Save the setting in the Detailed object level settings dialog. 
 

 



 

Step 10. 
Move saved files to the firm folder. 
 
Open the model folder. 
 

 
 
Open the attributes folder and select the files required. This will include all of the part 
settings as well as the finished object level saved setting. 
 

 
 



 

Step 11. 
 
Add all of the setting properties in use to the Naming conventions list created throughout 
these lessons. 
 
 

 

Object 
Type 

Name Part 
Prefix 

Part Start 
Number 

Assembly
/Cast Unit 

Prefix 

Assembly
/Cast Unit 

Start 
Number 

Filter  Drawing 
Object 
Setting 

Steel 
Beam 

Beam M 1 B 1 SS Beam Light 
Green 
Steel 

Hidden 

Steel 
Column 

Column M 1 C 1 SS 
Column 

Blue Steel 
Hidden 

Steel 
Brace 

Brace M 1 BR 1 SS 
Bracing 

Light 
Green 
Steel 

Hidden 

Steel 
Rafter 

Rafter M 1 R 1 SS Rafter Light 
Green 
Steel 

Hidden 

Steel 
Purlin 

Purlin M 1 PN 1 SS Purlin Light 
Green 
Steel 

Hidden 

Concrete 
Beam 

Beam - - CB 1 SIC Beam Black 
Concrete 
Hidden 

Concrete 
Column 

Column - - CC 1 SIC 
Column 

Black 
Concrete 
Hidden 

Concrete 
Pile 

Pile - - CP 1 SIC Pile Black 
Concrete 
Hidden 

Concrete 
Ledge 
Beam* 

Ledge 
Beam  

- - LB 1 SIC 
Ledge 
Beam 

Black 
Concrete 
Hidden 

Concrete 
Slab 

Slab - - S 1 SIC Slab Black 
Concrete 

Concrete  
Foundatio

n 

Pile Cap - - PC 1 SIC 
Foundatio

n 

Black 
Concrete 



 

This is the end of the tutorials for the system set up. We have only covered the basics here 
in order for you to get going. 
Using this knowledge you will be able to expand this simple set up into a much more 
comprehensive drawing office standard for your business. 
From adding the Drawing object level settings from the GA drawing level to the View Level, 
Manipulating more drawing object types instead of just Part, such as, the part marking and 
rebar marks to creating settings for propping layouts, erection schedules and much more. 
 
 


